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Introduction 

There are several ways to use the NCGMP09 schema while creating a geologic map. Each path implies its 
own workflow, set of tools, and problems.  Among these paths are:   

1. Heads-up digitizing an existing analog map (map image) into the NCGMP09 schema 

2. Creating a new map by heads-up interpretation and digitization of source data (field maps, 
aerial photographs, topographic images, other remote sensing images) within your GIS using the 
NCGMP09 schema 

3. Translating an existing GIS database into the NCGMP09 schema 

These exercises demonstrate these three paths. 

Prerequisites 
This course assumes you have the use of ArcGIS (version 10.1 or higher) and a reasonable familiarity 
with both ArcGIS and geologic mapping.  

Typography 
Computer file and folder (directory) names are shown in bold proportional serif font: C:\ArcGIS. Objects 
(feature datasets, feature classes, rasters) within a geodatabase are shown in the same font.  

Window, menu, sub-menu, and textbox names are in bold san-serif font; an inequality sign (>) is used to 
separate menu > submenu, e.g., File > Save, or <right-click> > Copy.  

Text you type, either in a textbox or at the command prompt, is denoted by bold mono-spaced serif 
font, e.g., to save a file under a new name in MSWord, click File > Save As and in the File Name: 

textbox enter MyNewFilename.doc 

Setup 
It is convenient to have additional resources in your ArcGIS installation. Install the following sets of files, 
all available in the Resources folder of the course disk: 

USGS Symbols.style   I recommend this file be placed in ArcGIS\DesktopNN.n\Styles 

GSC_FGDC-style  See contents of this folder. Install FGDC_GSC_20100414.style  

into ArcGIS\DesktopNN.n\Styles. Install 5 TrueType fonts  (*.ttf) 
by right-clicking on each and selecting Install. 

NCGMP09v1.1-Tools3_arc10.1 Copy the entire directory to, perhaps,  
\ArcGIS\DesktopNN.n\NCGMP09v1.1-Tools3_arc10.1, but can be 
anywhere.  
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Exercise 1. Digitize 1:100K-scale geologic map of the Purcell Mtn, WA 7.5' 
quadrangle 

We start with Washington Division of Geology and Earth Resources Open-file Report 87-16 by Hank 
Schasse. You will need the following source materials, all available in the Resources folder of this 
exercise: 

ContactsAndFaults100K.lyr ArcMap lyr file set up for digitizing 1:100K scale linework 

DMU_export.dbf  Prepared DMU table in dbase format, for import into your  
    DescriptionOfMapUnits table 

PurcellMtn.png    screen capture of part of WaDGER OFR87-16 

wa_ger_ofr87_16_ plt1.pdf     map sheet of WaDGER OFR87-16 in pdf format 

wa_ger_ofr87_16_text.pdf  text  of WaDGER OFR87-16 in pdf format 

You will create the following: 

PurcellMtn.gdb   an NCGMP09-format geodatabase 

PurcellMtn-TopologyReport.html output of TopologyCheck tool 

PurcellMtn-Validation.html   output of ValidateDatabase tool 

A page-size paper map made from PurcellMtn.gdb, scale 1:100K, using FGDC symbols, with 
mapunit colors given in PurcellMtnDMU.dbf 

0.  Start ArcMap and install the NCGMP09 toolbox 

Start ArcMap. When offered an existing project, CANCEL to start with an empty map composition. Open 
the ArcToolbox window. Right-click on an empty part of the ArcToolbox window and select Add 

Toolbox... In the Add Toolbox window that opens, navigate to your NCGMP09v1.1-Tools3_arc10.1 

directory and select NCGMP09v1.1_Toolbox3_Arc10.1.tbx. <Right-click> again on an empty part of the 
ArcToolbox window and Save Settings > To Default. 

1.  Make an empty NCGMP09 geodatabase specific to this project and add map tics and map 
boundary 

Start ArcMap if it is not already open. Open the ArcToolbox window.  

A. Run the NCGMP09 Tools for Arc10 > Create New Database script to make an empty 
geodatabase  

a. Make a new folder for your output workspace. I recommend a location such as 
c:\arcdata\PurcellMtn or c:\users\<username>\Documents\PurcellMtn. 

b. Name the new geodatabase PurcellMtn.gdb.  
c. Set the projection to Projected Coordinate Systems > StatePlane > NAD83 (USFeet) > 

Washington North FIPS 4601. We choose this projection to match the lidar data we will 
use later.  This is not the projection of the source map. Why is it OK to do this? 
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d. Make optional feature classes GeologicLines , OrientationPoints, and MapUnitPoints. 
e. You can enable edit tracking—or not. Don't add fields for cartographic representations. 

Check "Add LTYPE and PTTYPE". OK. 
B. Run the NCGMP09 Tools for Arc10 > MapOutline script.   

a. SE corner of Purcell Mtn 7.5' quad is at 46º30' N, 121º45' W.  Note that west longitudes are 
negative. SE longitude can be entered as -121.75 or -121 45 (degrees minutes or decimal 
degrees). SE latitude can be entered as 46 30 or 46.5.  

b. Leave IsNAD27 checked. (Why?)  
c. Tic spacing can be set to 7.5 minutes or left at 2.5 minutes. 
d. Use your newly-created PurcellMtn.gdb as the output geodatabase.  
e. Set output coordinate system to Projected Coordinate Systems > StatePlane > NAD83 

(USFeet) > Washington North FIPS 4601.  
f. OK. 
g. Look at the catalog for your new geodatabase. You should see feature classes MapOutline 

and tics at the top level.  
h. Add the tics feature class to your map composition.  

C. Save the map composition to your PurcellMtn workspace as PurcellMtn.mxd.  
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2.  Georegister scanned map image 

If you have not completed step 1, make a new working folder, copy the contents of folder Exercise1-

AutomateAnalogMap\2-GeoregisterScan into this folder, and double-click on 2PurcellMtn.mxd to start 
ArcMap.  

A. Copy file PurcellMtn.png from the Resources 
directory to your working folder.  

B. Add PurcellMtn.png to the map composition. 
You should get a warning message about 
missing spatial reference information. OK.  Save! 

C. Go to Customize > Toolbars and  
Georeferencing. Snapping should also be 
checked. 

D. Ensure that PurcellMtn.png shows in file 
window on the Georeferencing tool bar. Tap the 
Georeferencing dropdown and select Fit to 

Display. Check Auto Adjust also. 

E. Add links for the 4 corner tics. The tics are hard to see. The lower tics are marked by the 
intersection of half-length vertical bars with the map margin and are inside the map boundary. 
The SE corner (just above 45' on lower right of map image) will be easiest to find and add first. 
The upper tics are full crosses + 

i. Snapping Use Snapping should be checked.  

ii. Click on the Add Control Point button on the Georeferencing toolbar 

iii. Zoom into a tic in the map image.  

iv. Click on the tic location in the map image.  

v. Zoom out if need be. Click on the corresponding tic point symbol.  

vi. Repeat for remaining tics.  

F. Check residuals on the link table (View Link Table button on the Georeferencing toolbar). 
Because we are fitting 4 points—only 1 point of redundancy—the residuals should be excellent 
(less than 10 ft, or 0.03 mm at 1:100,000 map scale).  

G. If you are satisfied with your results, go back to Georeferencing dropdown and click Update 

Georeferencing. This will write a world file (PurcellMtn.pgwx) that describes the transformation 
from image coordinates to map coordinates and allows ArcMap to place the image in the 
correct place any time the image is loaded into a data frame with the correct coordinate system.  

H. Disable the Add Control Point tool by clicking on another icon, perhaps the Select Elements 

Tool. Turn the Georeferencing toolbar off: Customize > Toolbars > Georeferencing. 

I. Save (floppy-disk symbol) your map composition.  

3.  Setup for digitizing  

If you have not completed step 2, make a new working folder, copy the contents of folder Exercise1-

AutomateAnalogMap\3-SetupForDigitizing into this folder, and double-click on 3PurcellMtn.mxd to 
start ArcMap.  

A. Do you have the necessary toolbars? I usually work with  Advanced Editing, Editor, Snapping, 
Standard, Tools, and Topology  enabled 

B. Load the MapOutline you made into the ContactsAndFaults feature class.  
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i. Open the Catalog window, navigate to PurcellMtn.gdb/GeologicMap in your current 
workspace, right click on ContactsAndFaults, and LoadLoad Data...  The Simple Data 

Loader will open.  
ii. Click on the folder symbol to open the Open GeoDatabase window and navigate to 

PurcellMtn.gdb in your current workspace and select MapOutline. Click Open, Add, 
Next>, Next>, Next>, Next>, and Finish to load the data in MapOutline into the 
ContactsAndFaults feature class.  

C. Add ContactsAndFaults to the map composition.  
One of the challenges in working with the NCGMP09 schema is that most lines have multiple 
attributes. ContactsAndFaults100K.lyr sets up a four-fold view of ContactsAndFaults, such that 
attributes LTYPE (optional, not required by the NCGMP09 schema), ExistenceConfidence, 
IdentityConfidence, and LocationConfidenceMeters are all symbolized, so that you can see what 
the values of these attributes are. ContactsAndFaults100K.lyr also provides a set of templates 
that—when a template is selected and a line is created—set appropriate values for these 
attributes and the attribute Type.  

i. Click the Add Data button, navigate to the Resources folder in the course CD, and select 

ContactsAndFaults100K.lyr. Add.  
ii. In the Table of Contents, expand ContactsAndFaults100K if necessary. Right-click on 

LTYPE,   move down to Data, and select Repair Data Source...  Set the data source to 
PurcellMtn.gdb/GeologicMap/ContactsAndFaults in your current workspace. This should 
also fix data sources for sublayers ExistenceConfidence, IdentityConfidence, and 
LocationConfidenceMeters.  You should now see a red line that is the boundary of the 
Purcell Mountain 7.5-quadrangle.   

D. Tap the Snappingdropdown and ensure Use Snapping is checked. Intersection Snapping, 
Midpoint Snapping, and Tangent Snapping should all be enabled.  

E. Optional: enable Snap To Sketch.  
If you build polygons in bulk, using the NCGMP09 toolbox Make Polygons script, it is convenient 
to be able to digitize small polygons as a single arc—that is, to snap the endpoint of an arc to its 
own start point. This is “Snap to Sketch”.  
If you build polygons piecemeal, using the Construct Polygons tool on the Advanced Editing 
toolbar, it may be undesirable to have single-arc polygons, as every time you later build an 
adjoining polygon, using the shared bounding arc, you will create a copy of the initial polygon 
which must be deleted.   
You must have an active edit session to enable Snap To Sketch. In Table Of Contents, right-click 
on LTYPE (under ContactsAndFaults100K), scroll down to Edit Features, and click on Start 

Editing. Then tap the Snappingdropdown and click Snap To Sketch.  
F. Add some data to the DescriptionOfMapUnits table in PurcellMtn.gdb. For description of the 

DMU table, see the NCGMP09 documentation on the course CD. I have prepared a list of map-
unit codes, map-unit labels, names, ages, hierarchy codes, and symbols (colors) as spreadsheet 
file PurcellMtnDMU.dbf, largely so we can readily color map-unit polygons.  

i. Open the ArcMap Catalog window. Navigate to PurcellMtn.gdb/DescriptionOfMapUnits 
in your current workspace. Right-click on DescriptionOfMapUnits and scroll down to 
Load > Load Data…  In the Simple Data Loader window, click on the folder icon to bring 
up the Open GeoDatabase window. Navigate to the Resources folder on the course CD 
and select PurcellMtnDMU.dbf. Open. Add.   

ii. Next> and Next> to bring up a field mapping table (headings “Target Field” and 
“Matching Source Field”) in the Simple Data Loader window. Fields MapUnit, Label, 
Name, and Age should already be matched. Scroll down to HierarchyKey, click on 
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<None> in the second column, and scroll down to select HierarchyK.  
iii. Next>, Next>, and Finish.  

G. Add MapUnitPolys to the map composition. Click the Add Data button, navigate to 
PurcellMtn.gdb/GeologicMap in your current workspace, and select MapUnitPolys. Add. 

H. Join feature class MapUnitPolys to table DescriptionOfMapUnits. In the Table of Contents 
window, right-click on MapUnitPolys, scroll down to Joins and Relates, and Join…  In the Join 

Data window that opens, “Join attributes from a table” (top list-box) should already be selected.  
i. 1. Choose the field…  Select “MapUnit”. 
ii. 2. Choose the table…  Select DescriptionOfMapUnits from PurcellMtn.gdb in the current 

workspace.  
iii. 3. Choose the field …  Select “MapUnit”. 
iv. Join Options:  Select Keep all records 
v. OK.  You will get an error message about the joined table having no rows. ‘Tis OK.  

I. Set labeling and make MapUnitPolys semi-transparent.  
i. Double-click on MapUnitPolys to open the Layer Properties window. Tap the Labels 

tab. Check Label features in this layer. Method: should be ”Label all the features the 
same way”  (this is the default value).  At Label Field:, hit the drop-down arrow and 
scroll down to and select the second occurrence of “Label”. Change Text Symbol color 
to red.  

ii. Still in the Layer Properties window, tap the Display tab. Set Transparent: to 50%.  
iii. OK.  

J. Save (floppy-disk symbol) your map composition.  

4.  Digitize arcs and make polygons 

If you have not completed step 3, make a new working folder, copy the contents of folder Exercise1-

AutomateAnalogMap\4-Digitize into this folder, and double-click on 4PurcellMtn.mxd to start ArcMap. 
You may have to change the source of PurcellMtn.png. (In Table of Contents, right-click on 
PurcellMtn.png, tap Source tab, click Set Data Source…, navigate to your workspace for step 3, or to 
Exercise1-AutomateAnalogMap\3-SetupForDigitizing, and select PurcellMtn.png.) 

A. Digitize ContactsAndFaults. 

i. Right-click on ContactsAndFaults100k/LTYPE and navigate to EditFeatures > Start 

Editing. If feature templates do not appear, go to the ArcMap toolbar, tap the Editor 
dropdown, and navigate to EditingWindows > CreateFeatures.  

ii. Pick an LTYPE template and click away. Double-click or F2 to terminate a feature. 
Repeat. 

iii. Save Edits (available at Editor dropdown) frequently!  
Snapping: You really want to ensure that lines join precisely, without undershoots or overshoots. 
It is possible to fix such problems later, using various editing tools, but much more efficient to 
avoid them from the get-go. Do this by (1) setting the Snapping environment properly (see 
ArcGIS Help if you are unfamiliar with this), (2) digitizing at the appropriate scale (so snapping 
works as you wish it to), and (3) taking a modicum of care while digitizing.  
Working scale: If Windows is configured to properly recognize your monitor and monitor 
resolution, the scale statement on the ArcMap toolbar will be approximately correct. In general, I 
find it best to work at a somewhat larger scale than the intended final display scale AND to 
adjust the working scale so that edges are well defined (fuzzy features get sharper as they are 
shrunk).  
Choice of template: Use the working scale as a guide to setting LocationConfidenceMeters, i.e., 
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if a working scale of 1:10,000 gives moderately well-defined edges, select 
LocationConfidenceMeters to be 10.  If you are digitizing at 1:100,000 scale, select 
LocationConfidenceMeters of 100; a value of 30, or 10, is certainly not appropriate. It’s OK  to 
use approximate or rounded numbers for LocationConfidenceMeters. This attribute is a real 
(floating point) number not because we know it precisely but because we use it to denote a real-
world quantity. Integers are for counting, reals are for measuring. 
Strategy: Work from youngest to oldest. This eases snapping to correct line positions and gives 
the cleanest, most continuous lines and best symbolization. First create the map boundary. Then 
digitize Recent contacts (water boundaries, margins of modified land and artificial fill). Then 
digitize older Holocene arcs (young landslides, young alluvium, etc.). Continue into the past.  
Line direction: Some arcs, particularly low-angle faults, have ornaments that lie to one side of 
the arc. Typically such ornaments are on the right side of the arc, thus we digitize low-angle 
faults with the hanging wall to the right. An arc can be flipped after the fact:  while editing, and 
with the Edit Tool active, double-click on the arc, right-click on the arc, and select Flip.  
Managing multiple attributes: A properly-built, relatively small set of templates greatly eases 
the task of managing the multiple line attributes of the NCGMP09 schema. However, it is unlikely 
that any usable set of templates will allow you to specify all attributes of all arcs. For example, 
the templates in ContactsAndFaults100K.lyr do not create faults that are queried because their 
identity (e.g., contact versus fault, or strike-slip fault versus normal fault) is uncertain. Nor do the 
templates set DataSourceID values (was this arc digitized from an analog map, interpreted from 
aerial photographs, or walked in the field while creating a GPS tracklog?). Think about your map, 
build appropriate templates, hand-calculate some values, and use the edit-tracking attributes to 
identify arcs that were created or modified during the same edit session and thus (probably have 
a common data source.  

B. Make Polygons. Two methods for creating polygons from linework are the NCGMP09 Make 

Polygons script and the Advanced Editing Construct Polygons tool. 
i. NCGMP09 toolbox > Make Polygons is an enhanced wrapper for the Feature to Polygon 

(Data Management) script provided with ArcGIS. Make Polygons creates polygons from all 
arcs in ContactsAndFaults and labels these polys with both a) existing poly attributes and b) 
attributes of any MapUnitPoints label points.  Make Polygons also creates ancillary feature 
classes that identify unlabeled polygons, polygons with multiple label points, label points 
that are multiples within a single poly, and the polygons that border each arc segment. Its 
scope is the entire feature dataset.  
You can use Make Polygons to make unlabeled polygons that you later select and attribute 
with MapUnit, or you can add points to feature class MapUnitPoints that you attribute with 
MapUnit, and these values will be transferred to the created polygons.  

ii. Use the Construct Polygons tool to create polygons from selected arcs. Advantages of using 
this tool are (a) its limited scope and (b) its immediacy, including feedback on digitizing 
quality. The primary disadvantages are that (c) it is easy to create duplicate polygons that 
must be deleted, (d) not all conceivable polygons will be created, and (e) polygons must be 
labeled after they are created; any label points are ignored.  

iii. I typically create label points (Make Polygons method) or select newly created polygons 
(Construct Polygons method) and attribute these with MapUnit only, leaving all other 
attributes null—except that if the polygon label has a query (e.g., “Tva2?”), I set MapUnit = 
“Tva2” and IdentityConfidence = “questionable". I later open the attribute table of 
MapUnitPolys, select all polys with IdentityConfidence <> “questionable”, and calc 
IdentityConfidence of those polys to be “certain”.  I set Label and Symbol values later.  

C. Editor Save Edits. Editor Stop Editing.  
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D. Set polygon symbolization. In the Table of Contents window, double-click on MapUnitPolys to 
open the Layer Properties window. Select the Symbology tab.  

i. Under Show:  (left side of window), select Categories > Match to symbols in a style 
ii. Set Value Field to the second occurrence of Symbol in drop-down list.  

iii. Match to symbols in Style—tap Browse… and navigate to and select USGS Symbols.style. 
Remember where you put it?  

iv. Match Symbols. OK.  
Symbolization can be set before all polygons are labeled. And set again.  

E. Make and inspect topology. To create an unambiguous map, and to allow certain sorts of 
queries, it is important that contact and fault arcs not overlap, contact and fault arcs not 
intersect themselves, polygons not overlap, that there be no gaps between polygons, that there 
be no dangling unconcealed contacts (dangling concealed contacts and dangling faults are 
typically OK), and that all polygon boundaries are coincident with an unconcealed contact or 
fault.  

i. Check that you do not have an open edit session.  
ii. Open ArcToolbox. In the ArcToolbox window, open NCGMP09 Tools for Arc10. Double-click 

on Make Topology. For Input feature dataset, navigate to and select feature dataset 
PurcellMtn.gdb/GeologicMap in your current workspace. OK.  

iii. Open the Catalog window and navigate to PurcellMtn.gdb/GeologicMap in your current 
workspace. Add GeologicMap_topology to your map composition. You will be asked whether 
you also want to add participating feature classes. Answer No (they should already be 
present).  

iv. Start editing (right-click on MapUnitPolys and Edit Features > Start Editing). Look at the 
map for errors, and (or) open the Error Inspector window and check for errors. Note that 
ArcMap will tag dangling fault arcs as errors, but we accept them. You may mark them as 
exceptions. Fix any errors that you find. Re-validate the topology. Repeat until there are no 
errors. Your map should have one dangling fault arc.  

F. Editor Save Edits. Editor Stop Editing. Save your map composition.  

5.  Digitize orientation points and geologic lines 

If you have not completed step 4, make a new working folder, copy the contents of folder 
Exercise1-AutomateAnalogMap\5-DigitzeOrientationPointsAndGeologicLines into this folder, and 
double-click on 5PurcellMtn.mxd to start ArcMap. (You may have to change the source of 
PurcellMtn.png. In Table of Contents, right-click on PurcellMtn.png, tap Source tab, click Set 
Data Source…, navigate to your workspace for step 3, or to Exercise1-AutomateAnalogMap\3-

SetupForDigitizing, and select PurcellMtn.png.) 

We digitized lines using feature templates to set the multiple attributes that characterize NCGMP09-
style data. Our source map has only one flavor of orientation point (“bedding”) and two flavors of 
geologic line (“anticline axis” and “anticline axis, concealed”). We will manage without prepared feature 
templates—instead, we will digitize generic point and line features and manually set the relevant 
attributes.  If you are digitizing a variety of OrientationPoints Types (e.g., bedding, upright bedding, 
foliation, joint, stretching lineation) or GeologicLine Types, you will probably find it useful to create a 
palette of feature templates similar to that in ContactsAndFaults100K.lyr.  

A. Square your map with the world. We do this to have on-screen rotation = geographic rotation. At 
the ArcMap main menu, View > Data Frame Properties…  In the Data Frame Properties window, 
tap the General tab and adjust Rotation: until the map is square with the world. I find that a value of 
0.75 works for this region and map projection.  
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B. While you are at the General tab of the Data Frame Properties window, set Reference Scale: to 
1:100,000.  

C. Add OrientationPoints and GeologicLines to your map composition.  
i. Open the Catalog window.  
ii. Navigate to PurcellMtn.gdb/GeologicMap in your current workspace. Expand the 

GeologicMap feature dataset.  
iii. Drag OrientationPoints and drop it into the Table of Contents window. Repeat with 

GeologicLines.  
D. Create temporary symbology for OrientationPoints 

i. In the Table of Contents, expand OrientationPoints. Double-click on the symbol (probably a 
dark-colored dot) to bring up the Symbol Selector window. Next to Search:, tap the radio 
button for “All Styles”. Type "bedding" into the search window and hit <Enter>. Select 
symbol 06.02 from FGDC_GSC_20100414. Click on the Color:  dropdown and change the 
color of the symbol to something highly visible like bright red. OK to exit. 

ii. In the Table of Contents, double-click on "OrientationPoints" to summon the Layer 

Properties window. Click on the Labels tab. Check "Label features in this layer”. Set Label 

Field: to Inclination.  Set Text Symbol color to match 
your bedding symbol. Click Placement Properties..., 
click the Placement tab, and select Place label on top 

of the point. OK.  
iii. Select the Symbology tab in the Layer Properties 

window. Click on the Advanced dropdown and select 
Rotation...  Click the dropdown for Rotate Points by 

Angle in this field: and select "Azimuth". Ensure that 
Rotation Style: is Geographic. OK. OK. Save your .mxd 
again.  

E. Digitize orientation points.  
i. You may need to right-click on OrientationPoints in the 

Table of Contents window and re-start editing (Edit 

Features Start Editing). If the Create Features 
window is not available, click Editor and navigate to 

Editing Windows > Create Features. Go to the 
Create Features window and select the OrientationPoints template.  

ii. I find it quickest to first place all bedding points and then set their attributes:  
a. Zoom into the map. Select the OrientationPoints template from the Create 

Features window. Click on the center of a bedding attitude that is shown on the 
map. This will place an OrientationPoints marker with Azimuth = 0, Inclination=0, 
and labeled with Inclination. Go to the next attitude and repeat until you've added 

points for all bedding attitudes. Editor Save Edits! 
b. Select the Edit Tool on the Editor toolbar. Select a bedding symbol. Select the 

Rotate tool on the Editor toolbar. Grab an end of the bedding symbol and rotate it 
until it is aligned with the bedding attitude shown on the map. Go to the Attributes 
window and key in the inclination value shown on the map. Repeat until all bedding 

values are set. Editor Save Edits! 
c. In the Table of Contents, right-click on OrientationPoints and Open Attribute Table. 

In the OrientationPoints window that opens, right-click on the Type column then 
navigate to and click Field Calculator...  Set Type = "bedding". Then OK to set all 
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Type values to "bedding". Repeat for PlotAtScale = 120000, 
LocationConfidenceMeters = 100, IdentityConfidence = "certain", 
OrientationConfidenceDegrees = 5, LocationSourceID = "DAS1", and DataSourceID = 

"DAS1". Editor Save Edits!  Close the attribute table.  
F. Digitize geologic lines.  

i. Go to the Create Features window and select the GeologicLines template. On the map, 
digitize the exposed (continuous) anticline axis as one arc, then the concealed (dotted) 
anticline axis as a second arc.  

ii. In the Table of Contents window, right-click on OrientationPoints and Open Attribute Table. 
Highlight (click on left margin) one row. Is this dotted line on the map? If so, type Y into 
IsConcealed. Or N if not. Enter the appropriate value for the other row. For both rows, 
calculate Type = "anticline", ExistenceConfidence = "certain". IdentityConfidence = 

"certain", LocationConfidenceMeters = 200, and DataSourceID = ” DAS1”. Editor Save 
Edits! Editor Stop Editing. Close the OrientationPoints attribute table. 

The GeologicLines feature class is a hold-all for linear features that are present in the real world—
that is, they may be concealed and they may have uncertainty in their position, identity, and 
existence—but they and their kin do not participate in the map topology. If there are a large number 
and variety of such lines it may be appropriate to create one or more additional feature classes for 
some of these features. See the NCGMP09 documentation.  

6.  Add Metadata 

If you have not completed step 5, make a new working folder, copy the contents of folder 
Exercise1-AutomateAnalogMap\6-AddMetadata into this folder, and double-click on 
6PurcellMtn.mxd to start ArcMap.  

The NCGMP09 schema requires a significant internal feature-level metadata. You created some of this 
(e.g., values of LocationConfidenceMeters) as you digitized features. Now add the remainder. 

A. Back up the geodatabase. You are going to make significant, wholesale modifications to the 
geodatabase. Best to keep a copy, in case you screw things up. 

i. Open the ArcToolbox window. Expand NCGMP09 Tools for Arc10 and double-click Compact 

and Backup. For Input Geodatabase, tap the folder symbol and navigate to PurcellMtn.gdb 
in your current workspace. OK.  

ii. Look at your current workspace, either with a directory window or via the Catalog window. 
Note that the backup copy of the geodatabase.  

B. MapUnitPolys, IdentifyConfidence=certain. You have probably already noted which polygons have 
uncertain identities. You now need to specify IdentifyConfidence for the remainder.  In the Table of 

Contents window of ArcMap, right-click on MapUnitPolys and navigate to Open Attribute Table.  
i. Select some rows. 

a. At the upper left corner of the Table window, click the Table Options dropdown 
and Select by Attributes...  In the Select by Attributes window, build an SQL 
expression:   

1. Method: should be Create a new selection (the default). 
2. Double-click on MapUnitPolys.IdentityConfidence. The field name is 

compound because MapUnitPolys is joined to DescriptionOfMapUnits.  
3. Click on <>.  
4. Click on Get Unique Values.  
5. Double-click on ‘questionable’.  

b. Apply.  
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c. All rows in the MapUnitPolys feature attribute table should be highlighted except 
those with IdentityConfidence = “questionable”.  

ii. Calculate values. 
a. Right-click on the IdentityConfidence column heading and navigate to Field 

Calculator…  
b. In the text window MapUnitPolys.IdentityCOnfidence =, enter “certain”.  
c. OK.  
d. Clear the selection: Table Options Clear Selection.  

e. Editor Save Edits! 
C. Calc DataSourceIDs.  

i. In the MapUnitPolys attribute table, right-click on the heading of column DataSourceID and 
navigate to Field Calculator… In the text box MapUnitPolys.DataSourceID =, type “DAS1”. 
OK. Close the attribute table.  

ii. Open the attribute table for ContactsAndFaults (right-click on 
ContactsAndFaults100K/LTYPE). Calc DataSourceID = “DAS1”. Close the attribute table. 

iii. You have already set DataSourceIDs for OrientationPoints and GeologicLines. But you could 
check.  Note that OrientationPoints has both LocationSourceID and DataSourceID, as 
location and orientation may have separate sources. For this transcription, both should be 
“DAS1”.  

iv. Editor Save Edits! 
D. Add information to metadata tables DataSources and Glossary. 

i. Open Catalog window. Navigate to PurcellMtn.gdb in your current workspace. Add tables 
DataSources and Glossary to your map composition.  

ii. In the Table Of Contents window, right-click on DataSources and Open.  
So far, all the information in PurcellMtn.gdb has a single source: Washington DGER 
Open-file Report 87-16, by Hank Schasse, transcribed by you. You need to add an entry 
to describe this source.  
a. In table DataSources, in column DataSources_ID, enter DAS1.  
b. In column Source, enter an appropriate modification of the following (copy and 

paste works):   Geology of the Mount Rainier quadrangle, Washington, 
compiled by Henry W. Schasse, Washington Division of Geology and 

Earth Resources Open File Report 87-16, 1987, map scale 1:100,000. 

Digitized and interpreted by Ralph Haugerud in September-October 

2014.   

c. In the Notes field, you might enter an appropriate modification of the following:  
Values of LocationConfidenceMeters, ExistenceConfidence, 

IdentityConfidence, and OrientationConfidenceDegrees assigned by 

Haugerud on the basis of source map scale, source map symbolization, 

and his experience. These values may not coincide with the intent of 

the author of the source map.  

d. Close Table DataSources. Editor Save Edits.  
iii. In the Table Of Contents window, right-click on Glossary and Open.  

Table Glossary contains definitions of the terms used in an NCGMP09 geodatabase. All 
terms used in a Type field or a Confidence field should be defined here. We will later run 
a script to check that the list of terms defined in Glossary is complete. For now, we add a 
few that we can remember.   
a. In table Glossary, in the Term column, enter contact <return>. Continue to enter, in 

successive new rows of the Term column, fault, bedding, anticline, certain, and 
questionable.  

b. We leave Glossary_ID empty for now.  



12 
 

c. You have several choices for definitions. You may write your own. You may 
paraphrase definitions from your favorite dictionary or geology text. Or you may 
paraphrase definitions from the American Geological Institute’s Glossary of Geology 
(recommended).  

Note that certain and questionable are not defined in the AGI Glossary; the 
best definition for their meaning in this context that I am aware of is that on 
pages 16-17 of the FGDC Geologic Map Symbolization standard (FGDC-STD-013-
2006).  

d. In another document, draft your definitions. Copy and paste them into the 
appropriate Definition field in table Glossary.  

e. For each unique source of definitions, create a new DataSourceID value and enter it 
in the DefinitionSourceID field. If all definitions have the same source, all 
DefinitionSourceIDs will be the same (e.g., DAS2).  

f. Close Table Glossary. Editor Save Edits.  
iv. For each new value of DefinitionSourceID  that you created in Glossary, create a 

corresponding entry in table DataSources. See step ii, above.  
v. Add information to DescriptionOfMapUnits. In the Table of Contents window, right-click on 

DescriptionOfMapUnits and Open. You are going to provide additional attributes for each 
map unit identified in the DMU, but not for those rows that correspond to DMU headings. 

vi. Select rows that correspond to map units.  
a. In the Table window, tap the Table Options dropdown at the upper left corner of 

the window.  
b. Select By Attributes…  
c. In the Select By Attributes window, Method: should be Create a new selection (the 

default). In the list of fields below, double-click on “MapUnit”. Tap <>. Tap Get 

Unique Values.  In the list of unique values, double-click  ‘’.   
d. Apply. All rows of DescriptionOfMapUnits that have non-null values of MapUnit 

should now be highlighted.  
vii. FullName. Some map-units, on some maps, have names like “sandstone member” that are 

not informative until you know that this is the “sandstone member of the XYZ Formation.” 
Fullname is a field for storing the latter, compound name that might be used in a flyout that 
appears when a user’s cursor hovers over a map-unit polygon in a web display of the map.  

a. For this map, FullName can be the same as Name. Right-click on the FullName 
heading and open the Field Calculator…  

b. In the Field Calculator window, in the Fields: box, double-click on Name.  
c. OK. Values of FullName for all rows should now be the same as values of Name.  

viii. Description. In a better world our source-map text would not be a scanned image and we 
could copy map-unit descriptions from the source map and paste them into the DMU table. 
Unfortunately this is not possible 

a. Open file Resources/OCR/MapUnitDescriptions.docx in the course CD. Read the 
introduction on how this file was created. 

b. Copy map-unit descriptions and paste into appropriate places in Table 
DescriptionOfMapUnits. 

ix. DescriptionSourceID. Our descriptions all come from OFR 87-16.  
a. Right-click on the DescriptionSourceID heading and open the Field Calculator… 
b. In the Field Calculator window, in the DescriptionSourceID box, type “DAS1”. OK. 
c. Close Table DescriptionOfMapUnits.  

d. Editor Save Edits. 
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x. GeneralLithology 
a. Open the NCGMP09 documentation (Documentation/ usgs_of2010-

1335_NCGMP09.pdf) and the text for OFR 87-16 (Resources/ 

wa_ger_ofr87_16_text.pdf). Scroll to Appendix A. Lithology and Confidence Terms for 
GeneralLithology in the NCGMP09 documentation (p. 125 and following). 

b. For each map unit in table DescriptionOfMapUnits, find the GeneralLithology term 
that you think best fits. Copy and paste the GeneralLithology term into the 
appropriate row of the GeneralLithology column in DescriptionOfMapUnits. Also 
add the GeneralLithologyConfidence term (High, Medium, Low; page 134) that you 
find appropriate.  It is OK if no GeneralLithology term fits well—find the best-fitting 
term, either a general term that is uninformative or a specific term that omits some 
lithologies within the map unit—and set the corresponding value of 
GeneralLithologyConfidence to High, Medium, or Low as appropriate.  

c. Editor Save Edits. Editor Stop Editing.   
d. Close Table DescriptionOfMapUnits.  

E. Set ID values. Except for DataSources _ID and related DataSourceID values, you have not set any _ID 
or ID values. These can be created with an NCGMP09 toolbox script that creates new values for any 
missing values and preserves existing relations.  

i. Open the ArcToolbox window. Open NCGMP09 Tools for Arc10 and double-click on (re)Set 

ID values. In the Input  NCGMP09-style geodatabase field, click on the folder symbol and 
navigate to PurcellMtn.gdb in your current workspace. Select it and Add.  

ii. OK.  When script has completed, Close.  

7.  Check topology, symbolize, and validate your database.  

If you have not completed step 6, make a new working folder, copy the contents of folder 
Exercise1-AutomateAnalogMap\7-CheckSymbolizeValidate into this folder, and double-click on 
7PurcellMtn.mxd to start ArcMap.  

A. Check topology. Beyond requirements that lines not cross or dangle and that polygons neither 
overlap nor have gaps (step 4E above), there are other aspects of map topology that can be checked 
to guard against digitizing errors and implausible map relations.  

i. Run NCGMP09 Topology check script. Input geodatabase is PurcellMtn.gdb. Check the box 
to validate the topology of all feature datasets—you only have one, GeologicMap. Set map 
scale to 100000. You shouldn't need to change any other input values. OK. Note that the 
Topology check script is a work in progress.  

ii. Look at output file PurcellMtn_TopologyReport.html.  You should see one Line and point 
topology error: 

errors_GeologicMapTopology_line 
      1   Must Not Have Gaps   esriTRTAreaNoGaps 

You may also have an End-points of fault arcs that may need flipping error, which in this 
case (these fault lines are not directional) may be ignored.  
Note the tables showing how many arcs, and what cumulative length of arc, there are in the 
classes “Concealed contacts and faults”, “Contacts (not concealed)”, and “Faults (not 
concealed)”. These can be useful in identifying digitizing errors. One might imagine that for a 
large, complex map these might even teach you something about the stratigraphy of the 
map (is it layer-cake or not? What are the significant unconformities?) 

B. Set symbolization. One of the strengths of GIS, and of the NCGMP09 schema, is that symbolization 
may be almost entirely divorced from semantic content—that is, unlike with a paper map, heavy 
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black line need not equal fault. We choose to set symbolization separately from the Type, 
ExistenceConfidence, and other attributes of a feature. One advantage of this is that we can easily 
re-symbolize as we change the scale at which map data are to be displayed. Zoom out, so that 
1:24,000 scale becomes 1:100,000 scale, and many dashed contacts should be shown as continuous.  
You can pick line weights and colors that are appropriate for your display medium. And so on.  
If you choose to use FGDC symbology (FGDC Digital Cartographic Standard for Geologic Map 
Symbolization, FGDC-STD-013-2006, available on the web at ngmdb.usgs.gov), you may find the 
NCGMP09 Set Symbol Values script helpful.  

i. Run the NCGMP09 Set Symbol Values script. Open the ArcToolbox window, expand 
NCGMP09 Tools for Arc10, and double-click on Set Symbol Values.  

a. Set Feature dataset to PurcellMtn.gdb/GeologicMap in your current workspace.  
b. Set Map scale denominator to 100000.  
c. Accept defaults for the remainder of the script parameters. 
d. OK.  

ii. Set Symbol Values uses a dictionary file that you can edit to set Symbol values. This file, 
Type-FgdcSymbol.txt, lives in the Scripts folder of the NCGMP09 toolbox and lists Type 
values and a corresponding symbol identifier from the GSC implementation of the FGDC 
cartographic standard.  

a. For many line types (e.g., contact, fault) there are eight (23) line symbols defined in 
the FGDC cartographic standard for all combinations of is or is not concealed, 
location confidence (certain versus approximate,) and existence/identity confidence 
(queried or not). These line types are listed in the dictionary file under the heading 
Eight-fold Lines.  

b. Some structural orientation symbols have different forms depending on whether 
the orientation is known exactly or approximately—that is, whether 
OrientationConfidenceDegrees is less than some critical value. These, and other 
structural orientation symbols that do not have different forms, are listed under 
Two-fold Orientation Points.  

c. Other symbols are invariant once Type is given. Type-to-symbol mapping for such 
symbols is given under My Symbols.  

By default (but you can choose not to) Set Symbol Values also calculates some attribute 
values for polygons in MapUnitPolys. Symbol is set equal to DescriptionOfMapUnits.Symbol. 
Label is set to DescriptionOfMapUnits.Label, except for polygons for which 
IdentityConfidence <> certain, for which “?” is appended to the label.  
By default (but again you can choose not to), if this is the GeologicMap feature dataset and 
there is an OrientationPoints feature class, Set Symbol Values will create a new feature class 
OrientationPointLabels, add points to this class with attribute Inclination, position these 
points according to the dictates of the FGDC standard, and add a layer to your map 
composition that draws these labels with the font and size specified by the FGDC 
cartographic standard. You may find this a good start towards correctly positioned dip 
numbers.  

C. Validate your database and fix errors that are identified.  
i. First, Compact and Backup your database with the script in the NCGMP09 toolbox. 
ii. Run the NCGMP09 Validate Database script.  

a. Open the output file PurcellMtn-Validation.html. What errors are identified?  Likely 
problems include: 

1. Excess fields. You enabled error tracking on all feature classes and tables. 
While extensions to the schema are not errors, you are likely to choose not 



15 
 

to retain this information in the final, public, version of the database. In the 
ArcCatalog window, navigate down to PurcellMtn.gdb/GeologicMap in your 
current workspace, expand, right-click on each feature class, navigate down 
to Manage, and Disable Editor Tracking. OK.  In the Table Of Contents 
window, right-click on the corresponding layer, open the attribute table, 
navigate to the editor tracking fields, and delete them. Repeat for all feature 
classes in GeologicMap. Repeat for tables DataSources, 
DescriptionOfMapUnits, and Glossary.  Here is a script that needs to be 
written! 

2. Unneeded feature classes. MapOutline and tics (at the root level of the 
geodatabase) are excess. Delete them. You have not used 
GeologicMap/MapUnitPoints and it is optional. Delete it.  

3. Missing Glossary entries. Validate Database almost certainly will have 
identified several terms that should be defined in the Glossary table.  

a. Open the Glossary table for editing and add the missing terms.  
b. You also need to add values of Glossary_ID for each new term, 

either manually or by running the NCGMP09 (re)Set ID values script 
when you are done editing Glossary. 

c. GeneralLithology and GeneralLithologyConfidence terms are 
defined in Appendix A of the NCGMP09 standard. These terms 
should not be redefined! As a convenience to the users of your 
database, copy and paste the relevant definitions into Glossary. Add 
the appropriate value of DefinitionSourceID.  

d. Editor Save Edits. Editor Stop Editing.   
4. Validate Database is not smart enough to identify missing definitions, 

missing map unit descriptions, or lousy descriptions of data sources. 
However, it does list the contents of tables DataSources, 
DescriptionOfMapUnits, and Glossary. Scan these. Fix that which needs 
fixing.  

iii. Re-run the Validate Database script. Fix any remaining errors. Repeat until done.  

8.  Make a map image and print it. 

A. Go to View > Data Frame Properties...  on the ArcMap menu bar. Under the General tab, ensure 
that Reference Scale: = 1:100,000.  

B. Add unadorned ContactsAndFaults to your map composition. Either open the ArcCatalog window 
and drag, or click the Add Data icon and Add Data…  Uncheck ContactsAndFaults100K.  

C. Go back to Table Of Contents. Symbolize layers OrientationPoints, GeologicLines, and 
ContactsAndFaults with the FGDC cartographic standard.  

i. In the Table Of Contents window, double-click on OrientationPoints. In the Layer Properties 
window, click on the Symbology tab.  In the Show: box, select Categories > Match to 

symbols in a style. For Value Field, select Symbol. For Match to symbols in Style, click the 
Browse… button and scroll down and select FGDC_GSC_20100414.style. Open.  

ii. Back at the Layer Properties window, click Match Symbols. Uncheck <all other values>.  
iii. For OrientationPoints only, click the Advanced button and select Rotation…  Set Rotate 

Points by Angle in this field: to Azimuth. Ensure that the Geographic radio button is 
selected.  OK.  

iv. OK.  
v. Repeat for ContactsAndFaults and GeologicLines.  
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D. For MapUnitPolys, symbolize via Match to Symbols in Style, Value Field Symbol, and at Match to 

symbols in Style, Browse… to and select USGS Symbols.style. This style file may not be present in 
your ArcMap installation. It is available in the Resources folder of the course CD.  

E. Adjust the labeling of MapUnitPolys.  
F. Switch to Layout View and adjust. Save. File > Export Map…  and Save as type:   PDF (*.pdf).  Note 

that you may have to navigate to a different Save in: folder.  
G. Open the PDF with Adobe Reader and inspect. If everything is OK, print.  

Exercise 2. Digitize newly-interpreted geology 

Source materials 

 Your final version of PurcellMtn.gdb and the accompanying .mxd file.  

 Lidar data for part of the Purcell Mtn quadrangle and nearby areas, in geodatabase Lidar6ft.gdb 
in the Resources folder of the course CD. This geodatabase should be copied to your workspace.  

1.  Prepare lidar images 

A. Calculate useful images 
i. Open ArcMap with your most recent PurcellMtn .mxd.  
ii. Load Data; navigate to Lidar6ft.gdb/PurcellMtn. Load this raster into your .mxd.  
iii. Open the ArcMap Search window. Type "hillshade" into the search box and <ENTER>. Click 

on Hillshade and the Hillshade tool should pop open. 
There may be licensing issues that govern whether you can access Hillshade (3D Analyst) 
and/or Hillshade (Spatial Analyst). You may have to go to Customize > Extensions... and 
enable 3D Analyst and/or Spatial Analyst.  

iv. Make 3 hillshades.  
 

Input raster PurcellMtn PurcellMtn PurcellMtn 

Output hillshade Lidar6ft.gdb/ 

PurcellMtn_ne 

Lidar6ft.gdb/ 

PurcellMtn_nw 

Lidar6ft.gdb/ 

PurcellMtn_v10 

Azimuth 45 315 315 

Altitude 45 45 90 

Z factor 1 1 10 

 

i. The hillshades will be added to your map composition as you create them. Remove 
PurcellMtn_v10.  

ii. Return to the search window. Type "mod" into the search box and <ENTER>. This should 
bring up Mod (Spatial Analyst). Click on the tool name.  

iii. In the Mod tool window, Input Raster or constant value  1= PurcellMtn, Input raster or 
constant value 2 = 300, and Output raster = Lidar6ft.gdb/PurcellMtn_m300. OK.  

iv. Close the Search window.  
v. Remove PurcellMtn_m300 from your map composition.  

B. Go to Add Data and navigate to and add layer file PurcellMtn_e300.lyr, which is in the Resources 
folder of the course CD. You may need to repair the data sources. Uncheck raster layer PurcellMtn.  
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Your Table of Contents should now look something like the 
image at right.  

2.  Prepare to digitize 

A. Look around. Change which lidar-derived image is visible and 
look some more.  
How well does the 1:100K-scale geologic map depict the 
surficial geology in the area of lidar coverage? What's right? 
What's wrong? Can you see better interpretations?  What 
Quaternary map units might you depict? Make a list (mental, 
scratch paper, short text file...). What distinguishes these map 
units? What defines their boundaries? How precisely can you 
pick these boundaries? 

B. Enabling edit tracking for ContactsAndFaults. This will help you 
track which lines you digitized from OFR87-16 and which you 
interpreted from lidar topography.  

i. Open the Catalog window.  
ii. Navigate to 

PurcellMtnYI.gdb/GeologicMap/ContactsAndFaults. 
Right-click on ContactsAndFaults and navigate to ManageEnable Editor Tracking...    

iii. Click "Yes" 

3. Digitize new contacts 

A. Uncheck ContactsAndFaults and check ContactsAndFaults100K.  
B. In the Table of Contents, under ContactsAndFaults100K, right click on LTYPE and navigate to Edit 

FeaturesStart Editing. 
C. Digitize new contacts that you interpret from lidar topography, using the lidar image(s) of your 

choice. What scale do you find is easiest to work at, where boundaries are well defined, you have a 
decent field of view, and yet your digitizing isn't cramped? As a general rule of thumb, divide the 
denominator of this scale by 1,000 and the result is the appropriate value of 
LocationConfidenceMeters. Pick the line template to match. In this case, most of your lidar lines will 
be LTYPE = "contact  20m". A few contacts—e.g., between alluvial fans and valley-bottom alluvium—
may be very difficult to locate precisely and "contact 200m" may be more appropriate.  

D. It is easier to preserve data lineage if you do not modify existing lines. Digitize new lines. Cut old, 
superceded lines at their junctions with new lines and delete them. In general it will be easier to 
digitize new contacts, e.g., Qal (valley bottom) against bedrock (hillside) entirely and later trim / 
extend the existing contacts to meet the new contacts.  

E. EditorSave Edits frequently.   

4. Make topology and check for line errors. Build polygons 

A. Once you have completed, more-or-less, revising the linework, EditorStop Editing. Create line 
topology with the NCGMP09 Make topology tool. Add the resulting GeologicMap_topology feature 
class to your map composition and inspect. Fix any overlaps, self-intersections, or unintentional 
dangles. 

B. Make polygons. There are multiple ways to do this. 
i. Rebuild polygons with the NCGMP09 Make polygons tool. Attribute all new polygons, 
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perhaps in part with new map units. 
ii. Or, use tools on the advanced editing toolbar to create, cut, and merge polygons.  

C. If you have added new map units, you need to add these units to the DescriptionOfMapUnits table.  

EditorSave Edits.  
D. Check map topology with the NCGMP09 Topology check tool. Be particularly alert to the likelihood 

of bad nodes, now that the map has a more complicated digitizing-editing history. Fix any errors.  

5.  Fix metadata. Validate 

A. Start editing. Open Attribute Table for LTYPE. Sort on created_date values. Select those records 
created in this edit session. Use the Feature Calculator to set DataSourceID = “DAS7" (or whatever 
value is appropriate). 

B. If you modified existing lines (old or <Null> created_date, new last_edited_date, DataSourceID = 
DAS1), select these lines and calc DataSourceID = “DAS8” or whatever value is appropriate.  

C. Open table DataSources. Make an entry DataSources_ID = DAS7, Source = This report. 
Interpreted and digitized from 6ft lidar DEM by <yourname> on <thisdate>" or similar. 
If needed, make a second entry DAS8, Source =  OFR 86-17, digitized with minor 
modifications by <yourname> or similar.  

D. Editor Save Edits. Editor Stop Editing.   
E. Validate the database using the NCGMP09 Validate Database script. Fix significant problems.  
 

 

 

 

 


